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Safety 

All researchers working in 1238 Hach Hall must complete the EH&S courses: “Fire Safety and 
Extinguisher Training”, and “Lab Safety: Compressed Gas Cylinders”.  When preparing samples in 
1238A, please wear all appropriate personal protective equipment.  Aprons, safety glasses, and 
rubber gloves are available.   
 
Properly dispose of waste solvents and glass pipettes in the containers provided in 1238A.  All of 
the data processing computers and many of the data acquisition computers in this lab have direct 
links from the desktop to MSDS sheets, the EH&S Laboratory Safety Manual and to the CIF Safety 
Manual. 
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I. Prerequisites for Training 

The following prerequisites are required. 
 
A. Completion of a graduate level course with significant mass spectrometry content. 
 
B. A good understanding of gas chromatography acquired through experience or course work. 
 
Exceptions to these prerequisites will be made on a case by case basis.  The final decision will be 
made by CIF staff.  

 

 
II. Overview of the Magnum GCMS Instrument and Software. 

The Magnum GCMS is an ion-trap mass spectrometer coupled to a Varian 3400 gas chromatograph 
Both electron ionization (EI) and chemical ionization (CI) are possible, however EI is the normal 
operating mode. The mass spectrometer acquires data with “nominal mass” precision.  The mass 
peak width at half-height is approximately 0.7 Daltons.  When properly calibrated, mass 
measurements are accurate to about +/- 0.3 Daltons.  If you require greater mass measurement 
accuracy, consider using the Waters GCT GCMS, also located in 1238 Hach Hall.  NOTE: If you do not 
understand the information in this paragraph, then you fail to meet training Prerequisite A, a basic 
understanding of mass spectrometry. 
 
The instrument-control and data acquisition software is called Vx Acquisition, and includes all of 
the programs required for tuning the instrument, acquiring data, and converting the data to 
formats suitable for processing.  During the acquisition it is possible to view chromatograms and 
spectra, but it is not possible to process or print the data until the acquisition has finished.  
 
T 
hree software packages can be used for processing data.  These include Varian MS Workstation, 
Agilent Mass Hunter, and Waters Mass Lynx.  Each requires that the acquired data be converted to 
the appropriate format. At the moment, we are only teaching the Mass Lynx software.

 

  However, if 
you are already familiar with and have access to Mass Hunter or MS Workstation, you may prefer 
to use one of those packages. For each of these three packages, the availability of searchable mass 
spec libraries and the complexity of data conversion prior to processing is summarized in the table 
below. 

Software 
Package 

Library 
Availability 

Data Conversion Complexity Other Instruments 

MS Workstation Yes No user action required Saturn in undergrad 
lab 

Mass Lynx Yes Two step conversion 
(automatic) 

GCT in MS lab 

Mass Hunter Not yet One  user step required QTOF in MS lab 
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III. Ion Trap Mass Spectrometer Considerations 

Ion trap mass spectrometers have very good detection limits, but restricted dynamic range.  If too 
many ions are present in the trap (i.e. your sample is too concentrated), the quality of the mass 
spectrum deteriorates.  Through training, we will help you achieve the following goals: 
 
Make sure you are getting good data.  We have certain responsibilities related to instrument 
performance.  
 

Your responsibility is to follow the operational procedures we specify. 

Make sure you know the difference between good data and bad data.  Injecting more sample 
does NOT give better results, it gives worse results.  You need to be able to recognize a poor quality 
spectrum when you see one. 
 
Protect the capillary column from damage.  The GC column is very expensive and can be damaged 
by acids, bases, oxidizing agents, water, derivatizing reagents, particulates, et cetera. Be sure your 
samples are neutralized and filtered. 
 
Use important features of the software:   
 -Using single ion chromatograms to solve problems  
 -Averaging scans and subtracting background to achieve high quality spectra 
 -Adjusting library search parameters to give you the information you need  
 
Use the “Method Page” properly.  You have been assigned a default method page for data 
acquisition which can be easily modified and saved to meet your specific needs. 
 
 

 
IV. User Responsibilites  

ALWAYS make a proper entry in the logbook. 
 
ALWAYS place a copy of the GC trace and the spectrum at the apex of the largest peak in the 
binder.  Please write your name at the top of each page. 
 
ALL GC METHODS must end with a “bakeout” segment that takes the column to at least 280 
degrees and keeps it there for at least five minutes. 
 
ALL GC METHODS must have an injector temperature no lower than 180 degrees or higher than 
280 degrees.  Use the default value of 260 degrees unless you have a good reason not to. 
 
ALL ACQUISITION METHODS must have a filament/multiplier delay so that the mass spectrometer 
is not acquiring data on the solvent peak.  The proper delay time is a function of the column length, 
GC temperature program and the solvent.  A value of 2.5 minutes is about right for most situations.  
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If you are one of the very few people who must acquire data in the solvent region, you may reduce 
or eliminate the delay.  Don’t do it unless you have to! 
 
ALL ACQUISITION METHODS should use a low mass of 35.  The ion trap operates using a 
complicated set of pulse sequences, and as part of automatic gain control (AGC), the ion trap uses 
the region below mass 33 for other purposes. We are still learning how the Vx software works in 
that regard.  
 
ADJUST YOUR SAMPLE CONCENTRATION.  The ion trap

 

 works best with low nanogram amounts of 
sample.  You may still get good data at higher levels, but let’s use 2.5 nanograms as an example.  
Since you will be injecting one microliter of your mixture into the GC, and the injector is operating 
in "split mode” with a split ratio of approximately 40:1, the initial concentration of your solution 
should be about 100 nanograms/microliter. This is the same as 0.1 mg/mL.  This is roughly 
equivalent to a 0.01% solution.  By way of comparison, the NMR solutions you use are probably 
about 1-2%.  This means that an NMR solution should be diluted by at least a factor of 100 before 
being injected into the GCMS.  

 

 
V. Recognizing Good Spectra 

Your ability to recognize and print out good spectra is important. We have already talked about one 
of the key aspects, reducing sample concentrations to give appropriate detector signal levels. Other 
important factors include: 

-Selecting the correct scan from within the GC peak 
-Performing an appropriate manual or automatic background subtraction 
-Determining if certain masses in your spectra are “real”, or if they are: 

1) noise (very rare) 
2) column or septum bleed (common) 
3) a co-eluting or tailing GC peak (common) 

 
The most useful method for determining the purity of your spectrum is to generate single-ion mass 
chromatograms, discussed later in the Mass Lynx data processing part of this document.  Mass 
chromatograms allow you to display “single ion chromatograms” of interest over part of, or the 
entire, GC run.  For example, if you have a GC peak that elutes at a column temperature of 200 
degrees and a previous GC peak eluting a few seconds earlier, you might notice in the spectrum 
corresponding to the top of your GC peak that in addition to an expected molecular ion at m/z 150, 
there are masses at m/z 180 and m/z 207.  You can investigate the nature of these ions by using 
“mass chromatograms”. 
 
In addition to displaying the GC Total Ion Current trace, you would want to display mass 
chromatograms for the ions present at m/z 150, 180, and 207. You might then see that the m/z 150 
single-ion chromatogram trace clearly corresponds to the GC peak in the Total Ion Current display.  
However, the m/z 180 trace might clearly show that m/z 180 is the result of tailing from the GC 
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peak eluting prior to the peak you are investigating.  The m/z 207 mass chromatogram will 
probably show a continuous or gradually rising baseline at m/z 207.  This is a common column or 
septum bleed peak that increases as the temperature increases.  There might be a small increase in 
the bleed at the exact point where the GC peak elutes; large GC peaks can sometimes “carry” a 
little bleed with them. 
 
Mass chromatograms can also be used to determine if a GC peak is actually the combination of two 
or more components.  As long as the maxima of each component differs by at least one scan (or 
there is a significant difference in the peak profiles - lead-in, tailing, et cetera) you can usually 
display some combination of mass chromatograms that will help you identify which masses belong 
to which GC components.  A careful examination of  mass chromatograms will provide the 
information necessary to properly average scans and subtract background in order to get the most 
representative spectrum possible.   
 
 

 
VI. Recognizing the Molecular Ion 

Sometimes there can be confusion about whether an ion is the molecular ion.  Often it will seem to 
be at about the right mass, but may be one mass unit higher than you expected.  You have been 
instructed during your training that as a consequence of how an ion trap works, “self-CI” can occur.  
This can result in an MH+ ion and adduct ions.  Let’s review this.  The normal equations of 
ionization are: 
 

1) M + e- --> M+*. + 2e-

2) M
     (initial ionization event) 

+*. --> M+.

3) M
      (internal stabilization) 

+*. --> F1+.

4) M
 + N     (neutral loss fragmentation) 

+*. --> F2+ + R.

5)  F1
     (radical loss fragmentation) 

+. --> F3+ + R.

6) M + M
     (fragment ions also fragment) 

+*. --> MH+ + (M-H).

7) M + M
    (“self-CI”) 

+*. --> (M+A)+ + (M-A).

 
 (formation of adduct ions) 

 
Reactions 1 through 5 are unimolecular and occur rather quickly. Reactions 6 and 7, being 
bimolecular, are much slower.  In other common types of mass analyzers such as quadrupole mass 
spectrometers, ions are formed continually in the ion source and extracted continually into the 
mass filter.  The filter only allows ions of a specific m/z value to pass through to the detector, 
depending on the values of the RF and DC voltages.  All other masses are discriminated against, and 
are “thrown away”.  A complete mass spectrum is achieved by ramping the mass filter voltages 
through the entire mass range in about one second.  At any given moment in time, MOST of the 
ions formed in the source are being thrown away!  Ions formed in the source are extracted, 
“filtered”, and detected or eliminated, in just a few microseconds.  In a quadrupole, ions only live 
for a few microseconds.  There is not enough time for reactions 6 and 7 to significantly occur.  
(Actually, the amount of self-protonation that can occur is compound or “class” specific... there are 
some compounds that form an observable MH+ even in a quadrupole mass spectrometer.) 
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In an ion trap, ALL the ions formed during the ionization pulse (variable from 16 microseconds to 
24,999 microseconds) are collected in the trap.  None are thrown away.  Once the optimum 
number of ions has been collected, mass filtering occurs through a mass-dependant destabilization 
process.  Ions are ejected along a defined trajectory to the detector.  A complete mass spectrum is 
achieved by ramping the ejection criteria over a period of about 200 milliseconds for a complete 
scan.  The entire sequence is called a microscan.  You should now understand two things: 

-Why the ion trap is so sensitive (no ions are thrown away!) 
-Why reactions six and seven can occur (ions live in the trap for hundreds of milliseconds.) 

 
Although some “self-CI” may occur, the spectrum is still interpretable using all the classical rules for 
El spectra, because almost all the fragmentation originates from the M+. ion.  When investigating 
whether an ion is MH+, first determine if the ion is actually part of the compound.  Use “mass 
chromatograms” as explained previously.  Next, consider whether you have any nitrogen in your 
sample.  If there is no nitrogen in the molecule, the molecular weight cannot be at an odd mass.  
Therefore, the ion must be an MH+

 

, or the true molecular ion is at a higher mass and fragments so 
readily that it is not observed.  In this case, you may need to do CI (chemical ionization) to 
determine the molecular weight of the compound. 

 

 
VII. User Accounts 

 Only properly trained students will be given user accounts on the Magnum.  Accounts that are not 
used for more than six months are usually deleted.  Occasionally instrument access may be 
suspended for one or more users for a short period of time if problems have been detected 
pertaining to their usage of the instrument.  Access is granted as soon as the difficulty has been 
resolved.  
 
Your username for this computer is the same as your ISU email address, minus the @iastate.edu 
extension.  For example, my username is sveysey.  For billing purposes, the computer automatically 
records the length of your session based upon your login and logout times.  Be sure to log out of 
the computer when you are finished.   
 
All of your methods MUST be named with your username, followed by a one-digit number, e.g. 
sveysey1.   All of your data files

 

 MUST be named with the first five letters of your username, 
followed by a three digit number, e.g. sveys001.  NO EXCEPTIONS. 

 

 
VIII. Computer Etiquitte 

1) We may have loaded various software packages on this computer to serve the needs of 
different users.  Only use the software that you have been trained and authorized to use.  
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2) The Vx and Mass Lynx software packages require that all users have “administrator” 
privileges.  Do NOT make any changes to the software packages or the system settings. 
 

3) This computer is on the internet to facilitate data archival and billing.  Do NOT use this 
computer to browse the web, view your e-mail, or otherwise amuse yourself.  Do NOT 
download any files of any sort to this computer.   

 
 

Start the Vx Acquisition program by left-double-clicking the icon . The program will 
open to show three panes: 

IX. Acquiring Data Using Vx 

1) Explorer
2) 

 pane (left) in tree-structure: Used to easily move between parts of the program. 
Messages

3) 

 pane (bottom): Displays the status of program actions and alerts you to 
problems. 
Program

 
 pane (center): Initially displays the Welcome page; normally displays program tabs. 

NOTE:  Both Vx and MassLynx can be placed in your start-up file; both programs would then open 
automaticvally when you log onto the computer. 
 
The Explorer pane (shown on the next page) shows that the name of this PC is “MAGNUM”, and 
that the only instrument definition is also called “Magnum”.  For the Magnum instrument, there 
are five major software branches: 
 

Method (with branches) -used to set all GC and MS acquisition parameters 
Sequencer (with branches) -not used; controls GC auto-sampler if present 
Tune    -used by CIF staff to tune and calibrate the mass spec 
Shutdown   -used by CIF staff to initiate a controlled shutdown 
Feedback (with branches) -displays chromatogram and/or spectra during acquisition 
 

Left-clicking on any of the icons will open the program in the Program pane.  The normal entry 
point is, of course, “Method”.  This is where you will call up your own unique “acquisition page”, 
edit the appropriate GC and mass spec parameters, choose a filename, and start the data 
collection.   
 
IMPORTANT:  Use only YOUR own methods! 
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Software tree     “Method” branch expanded      “Feedback” branch expanded
  

 
 

 
Step One – Open Your Method 

 
 
 
From the task bar choose 
“Method -> Open…” A page 
of method files will appear.  
Left-click to highlight one of 
your methods, and then click 
on “Open”. 
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In the Program window, you will now see a series of tabs corresponding to the four parameter 
pages associated with setting up the GCMS for data acquisition. 
 

Magnum Edit (Scan Setup tab) -scan speed, mass range, acquisition time, calibration 
Varian 3400 Edit (Oven tab)  -GC temperature program 
Information    -sample information (non-critical) 
Target     - filename, file type, conversion macro (critical) 
 

 
Step Two - Magnum Edit 

 
 

Default parameters were selected for you when your method was initially set up.  The only 
Magnum Edit tab you may need to change is the “Scan Setup” tab.  The top portion is shown in the 
figure above.  Note that a calibration file acquired on October 8, 2009 has already been selected.  
As newer calibration files are acquired by CIF staff, you will need to select the most recent 
calibration file. 
 
The bottom half of the Scan Setup tab contains the “scan table”.  In the example below, note that 
the first scan segment specifies that the mass spectrometer will be “off” for the first 2.5 minutes.  
This is the equivalent of the “filament / multiplier delay” you are familiar with from the old 
Magnum software.  The second scan segment specifies that after 2.5 minutes, the mass 
spectrometer will turn on and acquire data for 15 minutes at two scans per second.  The scan range 
in this example is from m/z 35 to m/z 500.  Recall that the maximum m/z allowed is 650, and the 
minimum allowed is 35. 
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Step Three – Varian 3400 Edit 

Once again, default parameters were selected when the method was established.  You should 
normally only have to edit the parameters on the Oven tab. 
 

 
 
Leave the “standby” temperature at 150 degrees.  As you adjust the various segments of the GC 
temperature program, the graphical temperature display automatically changes.  As with the old 
Magnum software, be sure that your program includes a “bake-out step” of at least 5 minutes at a 
minimum of 280 degrees.   
 
Step Four – Enter Sample Information 
 

(optional) 

The information entered on this page will be kept in the electronic log file for the sample, but is not 
actually used by any aspect of instrument control or data acquisition.   
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Step Five – Target
 

 (this is the critical stuff!) 

This is where you will specify the path and filename for the data you plan to acquire.  The data 
format is also specified on this page.  All data is initially acquired by Vx in one default format 
(Teknivent - .tkf).  The data is then converted to one of several formats recognized by common 
mass spec processing software packages.  In our case, we wish to save the data in a format 
compatible with Mass Lynx.  Unfortunately Vx does not provide this conversion option.  Instead, 
we have set up your page to save the data in “netCDF” format, a common file interchange protocol.  
We have also written a macro program to pass this file to a part of the Mass Lynx software package 
that converts the data from netCDF format to Mass Lynx format.    
 
All of this should happen without any intervention on your part.  However, it is necessary that you 
strictly follow the path and file naming protocols we have established. 
 

 
 

Do not make any changes to the settings on this page other than the filename for the data you are 
about to acquire.  Use the “browse folders” button to set the path to your folder, and then change 
the filename.  The filename MUST start with the first five letters of your username, and end with 
three numbers.  In the example above, the username is “sveysey”.  The acquisition filename 
selected is “sveys001”.  
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Step Six – Connect to the Instrument and Start Data Collection 

Data acquisition requires a sequence of three steps.  First, there is a “handshake” that must be 
made between the PC and the instrument.  The Vx software uses “Connect” and “Disconnect” 
commands not only to make the handshake, but also as a way of clearing any unexpected 
hardware errors that might occur.  Once the PC and instrument are “connected”, the GC and mass 
spec methods you established need to be downloaded.  Finally, the acquisition must be started 
either by “arming” the Start button on the Varian 3400 GC front panel, or by “starting the 
acquisition” from Vx.   

 
 
Connect / Disconnect button (shown disconnected – press to connect) 
 
Download button (grayed out until the instrument is “connected”) 
 
 
Arm Acquisition (allows the Start Button on the Varian 3400 to trigger acquisition) 
 
Start Acquisition immediately 
 
 
Add 5 minutes to the run time 
 
Abort the run (data file is NOT saved!!!) 
 

 
 
The actual instrument status is reflected by the state of the action buttons shown above, and by 
the system status display buttons.  There are various configurations; the “armed and ready” state is 
shown below. 
 

 
 
 
Mass Spec armed and waiting for Start 
 
GC armed and waiting for Start 
 
Autosampler not present 
 
System ready and waiting for Start 
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In this configuration, simply inject your sample and press the “Start” button on the Varian 3400.  
Both the GC program and the mass spec data acquisition will start. 
 

 
Step Seven – Feedback: Viewing the Chromatogram and Mass Spectra 

Double-click the “Feedback” tab in the Explorer pane.  Vx software allows you to view the GC trace 
as it is being acquired, and allows you to view the mass spectrum of any GC peak that has been 
acquired.  You may also view “mass chromatograms”.  However, in this release of software you 
cannot interact with either display.  All data processing and printing must be done post-run. 
 

 
 
The mass spectrum selection cursor in the chromatogram view can only be moved by typing in a 
“Time” or “Scan#”, or by using the mouse to click on the blue arrow keys. 
 

 
The mass spectrum selection cursor moves when a time or scan number 
is entered, or when the mouse is used to click on the blue arrow keys. 
 
 
 

 
At the end of the run (runtime as specified in Magnum Edit -> Scan Table) the real-time display will 
go blank.  The data file will be automatically converted to “netCDF” format and stored in the 
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D:\MData\[username]\ directory.  A copy of the “netCDF” file is then automatically converted to 
Mass Lynx format, and stored in a communal data directory: D:\MLdata\[filename]\.  
 
The data file can now be opened from within the Mass Lynx data processing software package as 
described in the next section.  The Mass Lynx program may be started prior to, during, or after 
your use of Vx.  
 
 
 
 
X.  Processing Data Using Mass Lynx 

 
Starting Mass Lynx 

Start the Mass Lynx software by clicking on the desktop icon.     After about twenty 
seconds, you should see the following: 
 

 
 
As with the previous Magnum GCMS software, the normal entry point for data processing is the 
Chromatogram program.  Single-left-click on the “Chromatogram” heading and a window should 
now appear.  It may be empty, or it may show the last
 

 data file you processed. 
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Retrieving Data Files 
 
In the Chromatogram window, pull down the File menu and select “Open…”  This will bring up the 
file browser tab.  At the moment, all converted data files are stored automatically in the directory 
D:\MLdata.  Note that you can use this browser to preview the sample description, acquisition 
date, and acquired mass range.  Additional information is displayed in a separate text window by 
selecting the “Experiment…” button. 
 

   
 
 
 
 
 
Select the file you wish to process, 
choose “Replace”, and select “OK”.  
Your data file will replace whatever 
was previously in the Chromatogram 
view. 
 
 
 
 
 
 
 
 
 

 
   
 
 
NOTE:  In this example, 
the filename

 

 is sveys001, 
but carries with it the 
description “testmix” as 
assigned on the 
“Information” tab during 
Vx acquisition. 
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The “Spectrum” program can now be started by left-double-clicking anywhere within the 
Chromatogram window.  Note that in Chromatogram, a vertical selection bar

 

 will now be present.  
You may now browse the chromatogram and view spectra simply by using the left mouse button 
(left-click-drag) to grab the top triangle of the bar and move it within the Chromatogram view.  

 
 
The spectrum header shows both the scan number, and the retention time.  
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Chromatogram and Spectrum Views 
 
Both Chromatogram and Spectrum provide access to other programs. Each program view and 
subprogram view can be modified through the use of the pull-down menus and/or the button bar 
located along the top of the view.  Most of the actions and settings are easily reversible if you 
happen to choose an inappropriate setting; others can cause problems that are harder to recover 
from.  You will need to spend some time investigating which features are important to you and 
which features are either useless or dangerous.   
 

 
      l    l    l     l     l     l     l_ paste clipboard contents onto the display 
      l    l     l     l     l     l_ copy peak integration list to clipboard [use in Excel]      
      l    l     l     l     l_copy list of chromatogram data points to clipboard [use in Excel] 
      l    l     l     l_copy snapshot of the view to the clipboard [use in Word] 
      l    l     l_print the view in landscape mode 
      l    l_print the view in profile mode 
      l_open the file browser to select a data file 
 

 
        l    l     l           l     l     l_ toggle between add/replace trace 
        l    l     l           l     l_ toggle add/replace processing window 
        l    l     l           l_ annotate text into the view         
        l    l     l_ co-add spectra and subtract background           
        l    l_ integrate the chromatogram peaks; show peak areas         
        l_ generate single ion (mass) chromatograms   
 

  
Increase magnification range _________________________ l l l l l l l    
Decrease magnification range____________________________ l l l l l l       
Delete magnification range _________________________________ l l l l l  
Show just the Total Ion Current (GC) trace ________________________ l l l l 
Decrement scan in spectrum display ________________________________ l l l 
Increment scan in spectrum display ___________________________________ l l 
Reset display (normalize in X and Y) __________________________________ __ l  
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Many of the actions in Spectrum are the same as in Chromatogram.  An additional program, Library 
Search, can be called from the Spectrum toolbar: 
 

    
       l__ Library search button 
 
A “Molecular Weight / Isotope Pattern” calculator can be called from the Tools pull-down menu, 
but is not available from the toolbar. 
 
Library Search 
 
The spectrum displayed in the Spectrum view can be searched against two large computer libraries 
by clicking on the Search button, or by selecting “Tools -> Library Search”.  For best results, be sure 
to average the appropriate scans in the GC peak, and subtract representative background scans.  
The Search / Match page can be configured many different ways.  It is often useful to display the 
unknown spectra and the two or three best matches (including structures for those library entries 
containing them) and a list of the twenty best matches.   
 

 
Typical Library Search Results view 
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 “Chro, Spec and Libr” are the three processing programs that you will be using most often.  
However, MassLynx software contains many other features that may be helpful to you.  Several of 
the most useful include: 
 

-Averaging Scans and Subtracting Background 
-Mass Chromatograms 
-Integration Reports and Quantitation 
-Theoretical Isotopic Abundance Reports 
-Elemental Composition Reports (useful with “accurate mass” data; NOT Magnum data)  
 

Averaging scans and subtracting background 
 
Averaging several scans and subtracting several background scans can improve the quality of your 
spectrum, and improve the performance of the Library search program.  However, you must be 
aware of the potential problems and the actual limitations of spectrum averaging.  Before 
averaging scans you must answer two questions.  First:  Is the GC peak “pure”?  Am I averaging 
scans from the same component, or are some of the scans coming from a co-eluting GC peak?  
Proper use of the Mass Chromatogram tool will help you answer that question.  Second: Is the 
signal level of the individual scans appropriate for averaging?  If quantitation is important, be sure 
that none of the scans are saturating the detector.  
 
There are two ways to average scans.  The first method requires that you simply right-click and 
drag the mouse over the scans you wish to average.  The second method involves use of the 
Combine Spectra icon.  This program also allows you subtract a representative background. 
 

Click on the Combine Spectra button.     The following dialog box will open: 
  

 
 
Click in the “Average” field.  Right-click and drag the mouse over the scans in the chromatogram 
you wish to co-add.  Then click in the “Subtract” field.  Right-click and drag over an equal number 
(or slightly larger number) of scans in the baseline that you would like to subtract.  Notice that you 
can specify a degree of “over-subtraction” to be sure that all of the background ions are removed.  
A value of 1.1 is typical. 
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A typical background-subtracted spectrum 

 
Notice that the spectrum will now show the averaging and subtraction information. 
 
Mass chromatograms 
 
This is certainly one of the most useful tools at your disposal.  It can be used: 
 

a) To find the “needle in the haystack” by searching for a specific mass that you 
expect to appear in one or more GC peaks.   

b) To find all related compounds in a complex mixture by looking for fragmentation 
ions known to be representative of a class of compounds.   

c) To determine whether a GC peak is pure or is a mixture of more than one 
component.    

d) To determine whether a specific mass in a spectrum is from the sample, from 
background, or from the tail of a closely eluting peak. 

 
The program can be initiated in three ways.  The easiest method is to simply double-click on the 
mass of interest in the spectrum display. In this example, we are creating a single ion 
chromatogram for m/z 122.  Note in the results below that m/z 122 is a significant ion in the GC 
peaks at retention time 5.29 minutes and 6.66 minutes.  Inspection of representative spectra leads 
to the conclusion that m/z 122 is probably the molecular ion for the compound eluting at 5.29 
minutes, but is probably the C13 isotope peak (with a contribution from MH+) for the compound 
eluting at 6.66 minutes. 
 



22 
 

 
 
  

 
 

Typical mass chromatogram display 
 

Depending upon the toggle state of the Add/Replace button in the Chromatogram view, a new 
window is opened to show the mass chromatogram of the mass selected, or the contents of the 
existing window are replaced.  

The second and third ways to specify a mass chromatogram are by using the  button on the 
toolbar, or by selecting “Mass…” from the Display pull-down menu.  Simply type in the mass of the 
ion you would like displayed.  In this example the tolerance for the single ion display is a window of 
0.5 Daltons (+/- 0.25 Daltons).  This is appropriate for the precision of the “nominal mass” data 
acquired by the Magnum.  
 
If you are trying to find a particular GC peak in a complex mixture, you would normally calculate the 
molecular weight of the component (Spectrum view -> Tools -> Isotope Model…) and then enter 
that value in the Mass Chromatogram dialog box.   
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Integration reports and Quantitation 
 
Mass Lynx includes a complete quantitation package.  Quantitation is an advanced topic and will 
not be discussed here.  However, a simple integration report can be easily generated just by using 

the “Chromatogram Peak Integration” button .  The integration report is printed over the 
chromatogram.  Depending upon display settings, the chromatogram peaks are also annotated 
with retention times and areas.    
 

  
Typical chromatogram display after performing peak integration 

 
The integration report can also be sent to the Windows clipboard by using the “Detected Peaks” 

button .  The report can then be pasted into Excel or Word.  When using the “Peak 
Integration” button, be aware that the integration is performed using parameters set from the pull-
down menu (Chromatogram view -> Process -> Integrate…) and these parameters may need to be 
modified to meet your needs. Users have full control over the peak detection and integration 
algorithm. Probably too much control!   

 
A reasonable approach is to start with Apex Track Peak 
Integration enabled, and Smoothing disabled.  This 
allows the software to make most of the hard decisions 
for you.  However, you should still make sure that 
reasonable values are set in Peak Detect… and in 
Threshold…   
 
 
Normally choose Apex Track Peak Integration 
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Typical settings for Apex Track peak detection and integration 

 
Theoretical Isotopic Abundance Reports 
 
Occasionally it is helpful to compare the measured isotopic distribution to the theoretical 
distribution.  This is especially helpful if you suspect your compound contains hetero-atoms like 
silicon, sulfur, bromine or chlorine.  Be aware that attention to sample concentration and careful 
selection of scans to co-add is necessary because of the propensity for MH+ formation in ion-trap 
mass spectrometers. 
 
Access:  MassLynx -> Spectrum view -> Tools -> Isotope Model 
 

 
 
 
Note:  This program also calculates the accurate 
masses in addition to the theoretical isotope 
distributions.  This can be used as input to the 
Mass Chromatogram program. 
 
Use “Display -> List Spectrum” to show a list of 
the masses and intensities. 
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XI.  Archiving and Exporting Data 

Adobe Acrobat Writer is loaded on this PC.  Therefore, any “view” which can be printed can be 
saved as a PDF file.  Simply use the “File -> Print” command to select Acrobat Writer as the 
“printer”.   
 
The “Snapshot” button available in Chromatogram, Spectra, and Library can be used to screen 
capture the active window and store it on the Windows clipboard.  It can then be pasted into a 
Word document and saved.   
 
More sophisticated screen capture software called “Snag-It” is loaded on this PC.  See me if you 
would like to use this software.  
 
The actual chromatogram or spectra data points can be sent to the clipboard and then pasted into 
an Excel spreadsheet.  Similarly, the results of the Peak Integration program can be sent to the 
clipboard and then pasted into an Excel spreadsheet. 
 
There is additional software in the Mass Lynx folder ( Start -> Programs -> Mass Lynx -> Data 
Bridge) that can be used to convert your Magnum files (previously converted to Mass Lynx format) 
into ASCII format. 
 
The data files acquired by Vx are stored in your personal directory (D:\MData\[Username]\) in 
netCDF format.  These files are also present in the communal Mass Lynx data directory 
(D:\MLdata\) in Mass Lynx format. 
 
All data files on this PC are automatically archived each day to our network storage device.   
 
You may archive your own data to a USB memory stick or to a CD / DVD. 
 

 
XII. In Conclusion 

We have attempted to present the fundamentals of both acquisition software (Vx) and the 
processing software (Mass Lynx) in enough detail to allow you to immediately begin analyzing your 
GC mixtures.  We have presumed that you have a sound knowledge of the principles of gas 
chromatography and mass spectrometry.  If you are weak in either of those areas, you will need to 
educate yourself before you will be able to use this instrument safely and effectively.  


